Slide ID: 445-1128-5009

htma

region 1

Introduction te ExcellDashboards Part 2

Wiritten and Presented by
David H. Ringstrom, CPA
Accounting Advisors, Inc.
www.accountingadvisors.com



file:///x:/templates/445-1128.pptx

Slide ID: 368-1128

 Excel Versions

A o I

I'll be teachlng from the Mlcrosoft 365 versmn of Excel, and notmg any
differences or limitations in the legacy versions of Excel. References to | Home Insert  Page Layout
Excel 2013+, Excel 2016+, and so on mean a feature is available in all o
[ A Cut R
subsequent versnons, mdudmg Mlcrosoft 365 ) : Calibri

' B I U-
The Future of Excel Legacv Vers:ons ¥ Eqrmat Painter
I demonstrate each technique at

least twice, first by way of
numbered steps in PowerPoint,
and then in Excel.

£ WO N

Microsoft 365 Perpetual Licenses

(Formerly Office 365) Pay once for the software to
Subscription-based version of Microsoft || use on a single computer. No
Office, which includes Excel. Use the new features added until you
software on multiple devices, new buy a new license. Includes

calculation engine, eervices and more Excel 2019 Handouts include PDF of today S
fea:cures are rgllmg ogt that will Excel 2016 presentation along with an example

dramatically set this version apart from Excel 2013 workhook that contains most

past Excel versions. Excel 2010 examples I'll teach from as well as
www.microsoft365.com Excel 2007 and earlier related articles.

Email ask@davidringstrom.com if
you haven't received the handouts.
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1 [~ ‘"‘Xﬁﬁhw’
‘ - =IF(B1="(All)","All Products",B1) l
iVendors \T| Total Sgles

Disi this Reld vour sHeer s Whistlestop Fruit Stand 770  Top 5Vem1'ﬁem\
g y na A

: P 'Bob's Fruit
bas‘:gtg’:r&“éﬁt':r:ass:cz;%d”Ct) b ="Top 5 Vendors - "&IF(B1="(All)","All Products",B1)

Add either formula. The goal is to
have a formula that shows what
choice has been made from the slicer.

T Filters S lick in the formula bar
Product and type an = sign.

4 |Whistlestop Fruit Stand 495,770

5 |Bob's Fruit 02 746
5 Val T (P R T e {="Top 5 Vendors -\\£@1="(All)",“AII Products",B1) I
e lick once to select 372053 (6 ) SN\
Yotal Sales : Click the cell that contains the
321,368
formula, and then press Enter.
1,976,443

Defer Layout Update
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/ ynamic Pivot Chart Titles

=Top 5 Vend

: I
I Change to $A$3:$B%9 t'A?\Z
321,368 |

s 214,041 \
- 495,770

éndors !
ick Linked Picture Bstop Fruit Stand

for Top 5 Vendors | it
G H 1 J
5 Lso Whistlestop Fruit Stand 108,147
6 ,1;64 Fruitju 107,856
7 la7  FruitRUs 85,106
2 & Mountain Fruit 83,538
10:] Fruit Direct 82,030
17 3 Grand Total 466,677

1 ‘ The linked pictures shows

14| the correct data now.
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o
z 4
Whi 08,147 5 |Total Sales
Fruiti§ Choose Apples. - s 6
Fruit A i ) =
8 ¥
Mountain F 7 »H = H o |
. . / 3 ananas wi
Fruit Direct{__Apples v 1
Grand Totali Mixed Berries Oranges 11 || Oranges |
12 o
13
Top 5 Vendors -~Apples ¢ . >
_Top & 15Top 5 Vendors - All Products
(5 _ 15| ( NN
100" e chart title changes 16 s Chart HtE chEnge
80, automatically. ¢ 5 go9
17 automatically.
60,00 18
40,000 197_
20,000 20
° 21
Whistlestop Fruit Fruitju FruitR U 7 Bob's Fruit Mountain Fruit Fruitju Orang
Stand S
23
24
25
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4 of 28


file:///X:/Examples/Dashboard Example.xlsx
file:///c:/users/david/dropbox/images/3429.snag
file:///X:/Examples/Dashboard Example.xlsx

Slide ID: 3428

~Linked Picture/Slicer Conflict

N ) S (N )
Region |~ Total Sales  Vendors
Mid GA 691,787  Bob's Fruit
{North GA 2,108,437
;South GA @}, 449,414
Grand Total| 3,249,638

V¥

FruitRUs
Fruitju

'~ Total Sales |

1,416,079
383,506
235,373
308,852

'Atlanta
\Blue Ridge

2
3
4
S
6 |Brunswick
7

Fruit Direct

Middle Georgig
Mountain Fruit
Navel Oranges
Orange U Glad

Oranges 'n Onif

e arkesyille
8 |Maco
9 Valdo
10 \Grand
11
12 |

Linked pictures that

the slicer inoperable.

overlap a slicer can make

R A X Cut
.~ | Total Sales Ve
691,787 Bo B Cepy
2,108,437 Fri [
449,414 Fri
3,249,638 Fru

Paste Options:

E__' Total Sales
1,416,079
383,506
235,373
308,852
691,787

Multi-Select "Produ

it Connections

ve "Product’

Right-click the slicer. 1
=D

13 Product 1

| - Oranges *%% H Bajrﬁanas

15| .
| | Apples

= | ’iijxed Berries

|
|

17 |
18 |
19!

Dashboard | Regio ...
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ST

B4 Sendto Back

| Bananas
Assign Macro,,,

| MixedB .. _ _
°D Size and Properties..

!

E Slicer Settings..,

Regio. ...

' Dashboard |

. 5 | ¢ | B

Region |~ TotalSales  Vendors

‘Mid GA 220,842  Bob's Fruit
L INorth GA 381,234 Fruit Direct

‘South GA 113,901  FruitR Us
5 Grand Total 715,977  Fruitju
3 %City ¥ Total Sales Middie _Georg-ia
4 |Atianta 281,820 “N”:v”e':tg'r'_;:;':
5 |Blue Ridge 89,810 Orange U Glad
6 .}Brunswick 61,501 Ay
7 |Clarkesville 9604 | estop 1
2 Macon 2 Grand Total
9 I\/aldosta | 52,400

-l 215877

The slicer works properly now.]l
13 | Product )
14 |
15 |
16 |
17 |
18 |
19!

Mixed Berries

Apples

» Dashboard Regio ... (+)
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| & | B | € | B |jd4 4 S
Reglon ¥ Total Sales  Vendors 1 iRegion - | Total Sales
Mid GA 691,787 Bob's Fruit 2 'Mid GA 691,787 ta Review View

2,108,437  Fruit Direct 3 INorth GA (

}South GA

8 noard Examplexisx - Excel

=S — | ouble-click any number
\Atlanta 1,416,079 i B within a pivot table.
'Blue Ridge 383,506

Brunswick 235,373 )
i __QOranees 'n Onif

» ‘ Dashboard Regio ... ~':-E"

A B
Region |~ Total Sales g
Mid GA 691,787 |North GA Atlanta FruitR Us Oranges q —
NorthGA 2,108,437 ‘North GA Atlanta FruitRUs Apples Click any cell within the total
SouthGA , 449,414 |North GA Atlanta  FruitRUs Kiwi row to add a total formula.
Grand Total \§,249,'. “O\th GA Atlanta  FruitRUs Bananas .

N

—

2 ) The corresponding pivot A new worksheet appears
table is activated. with the underying detail.

None
Average

. Count
' r oy
Bob's Fruit Kiwi Catink Nl s

: ‘ = Rnh's Fruit Bananas__§ Max
. | Region | City | Vi .. (& » | Sheetl | Region | .. () e Sroduct | Monthly Sales | F
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Timeline Feature (Excel 2013+)

' Date

All Periods

Select any cell withina
pivot table that contains
at least one column of

.Orang
, dates in its source data.
Gran

' Mixed

Woeo S o E W M e

he pivot table only shows
| Sheet2 | sheett | .. @ data for that month.

e 8
Choose the Timeline —
Dﬂlick Clearto show
command from the Insert

Jan 2018 all data again. MONTHS

1 201

: ARS

or Analyze menus.

Insert Timelines ? 5 IAN 3 lick here to change QUARTERS
the time scale. MONTLS

v

Select a column, only columns 5| N\ 46062
containing dates will appear here.

DAYS

Right-click on a Timeline and choose
Remove if you wish to delete the object.
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“Sparklines and Timeline Compatibility Issues

‘ i vy (U= “Ar | = I P N =
[gl H ) ' v =03 ’:_ng, ﬂ ) A A Sparklines 'V
Home | Insert Page Layout Formulas Data Review View Developer ~ Home | Insert Page Layout Fa

_“"_11 % Cut Free add-in for creating Excel 2007compatible sparklines:
=3 Copy ~ http://sparklines-excel.blogspot.com/2009/03/auto-install-add-in-for-excel-2007.html

Paste
- Format Painter

Clipboard M| Font e Alignment 'Clipboard = Font

— £ L F L gl ALl B C D
58 Fruit B3 January B2 February B3 March

‘ = 2 |Apples 193 245 35
‘Row Labels | ~ | Sum of Cases Sold | Timeline: Works in Excel 2013 or higher.Donotmove 3 Qranges 409 s =
Apples 14441 | orresize. "
Bananas 12365
Kiwi

‘Mixed Berries

‘Oranges

‘Grand Total

\Apples

‘Oranges

agugmmwmm‘hwmu

B

13
15

b N

144 » M| Sheet2 ~ Sheetl . January - February . March . ¥J ' ' ' Ready | T3 |

hfma
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Sparklines Feature (Excel 2010+

B

c

A
Data Jan  Feb
1 \les 271
Select the cell(s) where you

want to put the Sparklines.

264

—

‘Sp T T
Apples

W o N o s W N

j Sparklines

Choose a Sparkline command
from the Insert menu.

A
N =l
Maps PivotChart 3D

Line (Column } Win/

- v Map-
= Tours Sparklines
L M N (6] P

A B C D
1 Da_ta 'Jan Feb . '.Marv )
2 |Apples 1 271 264 154)
3 |Oranges! _ 253 ___ 203 ____ 229
Create Sparklines

e data that you want

hfma
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-
=

B0 0N oW W N

A
Data Jan  Feb  Mar
|Apples 271 264 154,
|Oranges 253 203 229
Column sparklines.

A B re B
1 Data  Jan Feb Mar
2 |Apples 271 264 154
3 |Oranges 253 203 229
4 {
54
7 4
8 {
9 T : 1
=5 Line sparklines. }
11
A B )6 ) B
1 Data Jan Feb Mar
2 |Apples 271 264 -154
3 |Oranges 253 -203 229
4|
5 |
7|
2 |

Win/Loss sparklines. "Up"
bars represent positive
numbers, "down" negative.
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- Dashboard Sparklines

R N N | ) [
Data Jan Feb Mar
\Apples 271 264 154
\Oranges’ 253 203

'Sgarklines
\Apples = Hilw

‘Oranges Hnll
1 —

1 JAdd the data for the
- month of April.

3 |Oranges 253
s
\Sparklines
\Apples
|Oranges

Sparkline still shows
3 months only.

hfma
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WO W~ O U&= W N

JApples 271
jOranggsA

|

|Sparklines
|apptes, . gnal _

\

|Orang 7 Again add the data

| for the month of April.

| p—

File Home

PivotTable Recommende
PivotTables

Create Table ]

Where is the data for your table?

[=sAs1:sDs3|
¥ My table has headers

1
2
3

j Sparklines &)
A B C D E 4
- Ban B8 reb B var K4 Apr K3
/Apples 271 264 154 400
|Oranges 253 203 229 500

Sparkline now shows 4 months.
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Removing Sparklines

EQ To resize the range, click on a)
Edit Data from the Design - Itert  Pagelajout: e
menu, after activating the 3
sparkline cells. 1 ® calibri

‘ Vi [_] Low Point Faste 5 4 B 7
Line Column Win/ : ;i )
o [_| Negative Poin Clipboard =

Optional: Adjust column
widths and/or row heights Sparkline Type
to resize sparklines. 6 H A =

>y . ,
| 3l 5 |Apples 7ll_-l_l Apples

- o 1

j Sparkline Data 1 + .l
6 |Oranges L |Oranges

o remove sparklines: i : |
select the cells. el 3 | Sparklines are not viewable

Choose the ¢ 5 Jat you want in Excel 2007 and earlier.
Data Range: N3 £| i

Choose where you want the sparklines to be placed

Location Range: ISHSS SHS6

w Cancel |
http://sparkiines-excel.blogspot.com

offers a free add-in that allows

Clear Selected Sparkine =~ | Sparklines | - Sparklines functionality in Excel 2007
S —— ___.‘ —— e — ™ — —

hfma -
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B C D E F G H (4 | 22~ 5 | Tablel - Power Query Editor
gioJDCity Vendor Product Unit Cases Sold Total Sales File Home Transform Add Column

e iefis e Select any cell within the first list. (Make sure that | : 5 I [H [ Properties U
| © the header row is the same on all worksheets) o J %7 [} Advanced Editor
| 1/15/2022 North — . — S Close& Refresh — Manage
1/22/2022 North GA Atlanta FruitR Us Bananas Case 6868 75548 T Al M e Cojtmhs ™
| 1/29/2022 North GA Atlanta Fruit R Us Mixed Bet Case 1996 29940 g} Soseitoay

Goal: merge 3 worksheets into a single consolidated % =} - vebie:TransFormco

list that is refreshable when new data is added. :
— , £ [ Date |~ || A8 Region

Guernies

1 1/1/2022 12:00:00 AM North GA

2 1/8/2022 12:00:00 AM North GA

C D mport Data X

-

sy 1 )Date TRegion City Vendor Prdllselect how you want to view this data in your workbook,
Page Layout Formulas 4)2 || Create Table ? % s orfd [ O1able
e — g Where is the data for your table?
ecent Existing Refresh | 5 )13 - =I5 £
S Sources Connections al~ 611 My table has headers s Mi V‘"'S*ﬁ doyo
et & Tr og 7 4 ——— Aft i
, er you click OK repeat steps
@ I

B This command may also 8 | (o )| Conce 1-8 for other worksheets.
ion appear as From Sheet in 9 \ a

hg| certain versions of Excel. 10| | [[] Add this data
anuary Mi February | Marc Properties... = (¢ 0K 4’ | Cancel

12 of 28
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Queries & Connections Task Pane

A
1 [0 v PR~ R - T T - e~ Quieries & Connections

Queries | Connections

\ 3/15/20220 00| The Quenes & Connect!ons panel shows the 3 queries
5 | 3/22/2022 0:00 _
' = £ Tabiel
6 |3/29/2022 0:00

Connection only.

10 Connection Only means the data can be 3 Table2
referenced within Power Query but the data itself Connection only.
doesn't appear on a worksheet. Hover over the
1 connection name to see a preview of the data. [ Table3
'1—1\ ' ' rows loaded.
] x rows loaded means the data appears on a worksheet in
the workbook. Click once on the connection name to
activate the corresponding worksheet.

.l wa v .

12)

The March data was inadverently loaded to a worksheet, which means it
appear so both the March and Table3 worksheets. To eliminate the duplication
simply delete the Table3 worksheet to make March be Connection Only.

| January | February{_Table3 | Marc

hfma

region

13 of 28


file:///X:/Examples/Combine Worksheets.xlsx
file:///c:/users/david/dropbox/images/5290.snag
file:///X:/Examples/Combine Worksheets.xlsx

Slide ID: 5291

Queries & Connections Task Pane

Click here to close the Queries

& Connections panel. 3 querie®

(3 Table
Connection B

Copy

(3 Table2

Connection| &4 Edit

Delete

[ Tabie3 '1

Connection

Queries & Connections

Review View )
Queries | Connections

3 queries

Click Queries & Connections
to display the Queries &

Connections task pane.
Type a new name and press

Srodu il 4525 Sl 1 OLal >dies 1
SE— —hs aa (oot sales] Enter. This has the same effect

Dranges  Case 2482 34
\pples Case 4588

hfma

region

as renaming inside Power Query.

Queries & Connections

Queries | Connections
3 gueries

B3 January

Connection only.

[ February
Connection only.

(] March
Connection only.

@l\

Taking the time to rename
queries makes working with
multiple data sets far less
confusing and frustrating.
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8]

- Combining Worksheets with Power Query

)r@ Worksh!

AutoSave =

D:I From Database

[5- From Azure
am

hima

region

Two tables

Available tables Tables to append

January January

. i ;
February February

March " March

- /

Hold down the Ctrl key while you select all three
tables. Alternatively click on the first table, and

hold the Shift key while you click on the last table.

| January | February | March
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/ Comblmng Worksheets with Power Query

af b eVec Jo UV UG AN

j 1/25/2022 12:00:00 AM North GA Queries 4] < fx | ?‘ | Append1 - Power Query Editor
8 TE El January @ Transform Add Column
The March dates are missing = b = =
. - I
because of an inconsistent ok 5 [y Properties u
column heading . i LT Advanced Editor
os€ e Refresh Manage
Load~ Preview~ E2 Manage ~ Columns ¥
Close Query
:'.-'":":. - ( "‘
. i —
Correct Month to be Date as it EE) Table . [E2 pate
appears on the other sheets. [ Table2 :
1 1/1/20]
7] Table3 ‘

° % || = Table.Combine({3a 32 1/29/2022 12:00:00 AM North GA
1 [\ 2l [aman A s e aa s B oA
" . ~ = = B
£ 9 B ate A Regionll The March dates now appear when
= >
o S/ Click here to expand |North GA

The combined list appears on a

the navigation pane. |North G new worksheet. If you add new

| o #iNorth GA :00: North GA items to the other worksheets

4 1/22/2022 12:00:00 AM  North GA 3/1/2022 12:00:00 AM North GA click Refresh All on the Data menu
|5 | 1/29/2022 12:00:00 AM  North GA 3/5/2022 1200:00 AM North GA to update this combined list.
1 & SLIDRITNLAM) | et 68 3/15/2022 12:00:00 AM North GA :00 North GA Atlanta FruitR
4 7 ' 2/7/2022 12:00:00 AM North GA / 3/22/2022 12:00:00 AM North GA 3:00 North GA Atlanta EruitRU
| 8 2/13/2022 12:00:00 AM North GA 3/29/2022 12:00:00 AM North GA oot ehoctt @

= ~~ - o

hfma
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A z C D A 7 A B €
i@l Date B Region B city B vendor B pr [EW) Date Region [ city B vendor [E Date B region B city B vendor
2/ ! 1/1/2022 North GA Atlanta FruitRUs O 1/1/2022 0:00 North GA Atlanta FruitRU| 2 | 1/1/20220:00 North GA Atlanta FruitRU
f 1/8/2022 North GA Atlanta FruitRUs Adl 3 | 1/8/R@2? aennlnarth o Atlanta eritr () 3 1/8/20220:00!North GA Atlanta FruitRU
4 11/15/2022 North GA Atlanta FruitRUs Ki 1&{/ Cut I 4 | 1/15/2022 0:00 North GA Atlanta FruitRU
5 |1/22/2022 North GA Atlanta FruitRUs B3 30 5 | 1/22/20220:00 North GA Atlanta FruitRU
6 \1/29/2022 Nogfh GA Atlanta Fruit R Us Right-click any cell in the 6 | 1/29/20220:00 North GA_Atlanta FruitR U
7 | 1/1/2022/Nd Bh GA Atlanta FruitR Us O combined list. 7/ 1/1/20220:00 North GA Atlanta Fruit R )
8 1/3’[20'22# th GA Atlanta FruitRUs Ag ' r’l‘" | 1/8/2022 0:00 North GA Atlanta FruitR
9 |1/15/2022/ [RthGA Atlanta FruitRUs Ki O | 1/15/2022 0:00 North GA Atlanta FruitR
10|1/22/2027 frth GA Atlanta FruitRUs Ba Paste Special.. 19 | 1/22/20220:00 North GA Atlanta FruitRU
11 1/29/207 irth GA Atlanta | letRUs M U O Smart Lookup 11\.1/29/2023 0:00 North GA Atlanta Fruit RY

36) / o (Chll v

Copy and paste the January data
or otherwise add new records. ‘

'3@ 2/1/2}/ :00 North GA Atlanta FruitR U

The new January data appears. |
CAVEAT: Newdataonly ~ fY

v

Insert

2
3
2
2
2
3
2
2

3/22/ ; appears in the consolidated list Y
16 | 3/29/ g % when the individual lists are U
17| Select > tables. If they're normal cell u
18 | ranges Power Query won't R U
‘ | Clear Contents " " ' ;
19| 1 see” the new dataand won't RU
20| 5] Quick Analysis comblne it mto the llst U
21| : : — — - U
| Sort

2

B > January | February ... '-}T W Rt 10 [ 24| March | Sheet B )
htma
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- Power Query Properties

1/1/2022 0:00 North GA Atlanta
‘ 1/8/2022 0:00 North GA Atlanta
1/15/2022 0:00 North GA Atlanta

10| 1/22/2022 0:00 North GA Atlanta FruitRU
» | Appendl January

AutoSave f

1/8/2022 0:00 Northd

hfma

region

Query Properties

Query name: Append1
Description: 1)

Background refresh results in confusion because if
you don't know where to look on the status bar it's
easy to overlook that Excel is still updating the query.

Usage  Definition

Refresh control

Enable background refres

[ Refreshevery (60 "5 minutes

This setting makes the query
automatically update itself when you open
the workbook that contains the query.

OLAP Server Formatting

Retrieve the following f Fast Data load is notavailable in older
versions of Excel, but speeds up the
Font Style Te loading process when available.

OLAP Drill Through

Number Format

Maximum number of records to retrieve

IMPORTANT: These settings
have to be established for B lsnguage when avallable
each query in the workbook. '
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H Combine Worksheets.xlsx - Excel PivotTable Tools

r
Home Insert Page Layout Formulas Data Review View Hn @ Design £ Tell me what you want to do

— F [Z Clear~
G (g ! =1 P Pt ;
2.4 Y ot EE [T} Select -
Insert  Insert Refresh Change Data
[3 Move PivotTable

Shicer Timeline v Source ~

PivotTable Active Field Group Filtar Nata Artinne
A B E PivotTable Options ﬂ_XJ

{Row Labels |~ lSum of Total Sales PivotTable Mame: | PivotTablel
|Apples 148231
'Bananas 167005
| Kiwi 110524 PivotTable Data
\Mixed Berries 123661 I Save source data with file
.EOranges 145015 V' Enable show details
» ]Lime 20000 =¥ Refresh data when opening the @
8 ‘ECoconut : 25000 Retain items deleted from the data source

9 .\Grand Total Check this box if you want to Number of items to retain per field: I'—'-.utomatic "I
10 | refresh data when opening the file.
11 ‘ — -p -~

12 |

13 _ Cancel |

14 |

Layout & Format I Totals & Filters | Display | Printing @ AItTextl

What-If Analysis

™ Enable cell editing In the values area

Combined | January | February | March

hfma 1
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1

|=[@[Total Sales]]/[@[Cases Sold]]

Data returned from Microsoft
Query is automatically formatted

as a table. When crafting formulas
that reference data within a table

Excel uses the field name instead
of a cell reference.

T

4588 21611
4274 16106
1902 44722
2512 33087

H |

Total Salesﬂ Per Case Price B
61680 10.00/1
66638 :

Type the cell address manually
instead of clicking on the cells
within the table if you prefer to
see cell addresses. Updating any
cell within a column of formulas
updates the entire column.

21611 4.71 |
16106 3.77
44722 23.51 |
33087 13.17,

| Sheet January |
hfma
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Sheetl | January | Februa

[Ee=

L‘fc Change options related to formula caldg

Calculation options
Workbook Calculation®
e Automatic
Automatic except for data tables
Manual

Waorking with formulas

[C] RIC1 reference style

[V] Eormula AutoCompiete

Use table names in formulas

Alternative: Clear the checkbox

for Use Table Names in Formulas
in the Formulas section of Excel's
Options dialog box and then click
OK. From then on you can click on

cells within a table and see the
cell addresses instead of field
names.

20 of 28


file:///X:/Examples/Fruitsales.csv
file:///c:/users/david/dropbox/images/2618.snag
file:///X:/Examples/Fruitsales.csv

Slide ID: 521

Group and Ungroup Rows and Columns

1

2

3 | ]

4 |Labor 2 8 [Total Income | 447,586
5 |Materia 3 |DESIER TRcome 13 |Total COGS . 141,631
& |Subcontracted Labor Income 4 |Labor Income 208,225 4 |Gross Profit . 305,955
Bl Total Income 5 |Materials Income 119,921 “<qtal Expense ‘. 74,721
9 |cost of quds sold | ? Subcontracted Labor Income 82,710 Usé this Beiftons to axpanid of
o0 Matestals 83270 |} & |Total Income collapse the spreadsheet.

j Group & Ungroup |

T A | 2rE
7 B2 HE
What-If Forecast Group
Analysis~ Sheet v

Group rows 2:6, 9:12, and
15:26 in the same fashlon.

What-If Forecast Group Ungroup Subtotal
Analysis~ Sheet v v

Outline

Forecast Forecast

Subcontracted Labor Income 82 710 :

:Total Income 447,586

| Group & Ungroup \ ®

SO W s W N

Clear Outline

AE | AF | AG | AH

ca

hfma
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- Custom Views - Multipurpose Worksheets

(4 A B

0l

lick to select the
entire worksheet.

Subcontracted Labor Income

;. |Total Income
Cost of Goods Sold
Job Materials

Materials Income Format Cells...

Subcontracted Labc Column Width...

Total Income Hide

Cost of Goods 50183
Job Materials

R o = < IRCS » N ) BN SRR ¥ E R (5 R

Custom Views-Financial St

10 |Job Materials

hfma

region

Insert Custom Views-Financial Staternent ~

Delete
Formulas Data

Layout

Subcontracted Labot Row Height...

Total Income Hide Custom Views

Cost of Goods Sold 5 Views:
Job Materials udll w

Custom Views-Financial St

6 Subcontracted Labor Income
ol

Include in view
Print settings
8270 Hidden rows, columns and filter settinas

8 éTotal Income
2 Cost of Goods Sold

1 1 mb Cancel

Custom Views-Financial St
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Hold down the Ctrl key and
select columnsE, |, M, and Q
(all 4 of the Quarter columns).

Total Income
Cost of Goods Sold
Job Materials

]

Navigation Gridlines

-

Doy ight-click column Q.

Labor”
Mater Format Cells...

Subco Column Width..,

Cost G

Job M Unhide

,000
,434

180,443

0 00~ L B N e

—

43,388
Custom Views-Financial St

Custom Views

Views:

Data Review View

]

Navigation

out Formulas

v Gridlines

Show

All Periods

hfma

region

Add (=

Include in view

[ print settings
[] Hidden rows, columns and filter settings

Cancel

Q-nllick Show to choose the All
Periods view to unhide all
columns at once. Add
additional views as needed.

300

oI

B,570 5,592 4,587 2,927 7

p,378 19,255 17,589 28

20,954
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Streamlining Custom Views

Ij?fﬂ Customize the Quick 4 hoose a workbook that has
custom views within it.

12 Mont
Customize Quick Access Toolbar
Page Layo

Automatically Save

If you don't see the Quick
Access Toolbar right-click on
File and choose Show Quick
Access Toolbar.

Excel Opticns

Ge,rs\k Y
The Quick Access Toolbar
section of the Excel Options
dialog box appears.

Conditional Forn

@ Copy

Custom Sort...

Add-ins

hfma

region

ST S

5}: commands from:G
ommands Not in the Ribbon S b

@vﬁom Views )

&ccess Toolbandi

Customiize Ribbon

l Dark Shading
]‘_‘V Depth

iN! Diagonal Down Border

File Home Insert Page Layout

7\

ny view can be chosen from

this list without having to
activate the View menu.
\

-
Custom Views [Quarters Only [

Quarters Only

Summary

or 12 Month Income Statementa@

Custom Views

File Home Insert Page Layout Fo

A | e X
ptional: To remove the list
right-click on the arrow.
Undo " Clpboard 1S \

Custom Views Quarters Only

Q‘Emove from Quick Access Toolbap

Customize Quick Access Toolbar...

1 Summ
Show Quick Access Toolbar Above t
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PivotTable Recommended Illustrations  Adq
PivotTables 4 Y i
Tables

A B C

H®-c- s Ho-c- -

File

Home Insert Page Layout Fo File Home Insert Page Layout Fc

[£] Page Layout

1 lRegion , V'VI City vflVendor

North GA Atlanta FruitR Us
|North GA Atlanta Fruit R Us
|North GA Atlanta Bob's Fruit
|North GA Atlanta Bob's Fruit

N ST 2]

- N Where is the data for your table?
N [=sasi:srssi 4

[V My table has headers

@I D ane |

Normal Page Break (| ¢yctom Views Gridlines
Preview

Workbook Views
| A B c
1 |Region City Vendor
2 |North GA Atlanta  FruitRUs

Customviews BB

Views:

e M T T W o

Removing all tables from a
workbook restores access
to custom views. The views
remain intact while tables
are present in the workbook.

Fruit Sales
htma

region

| Fruit Sales |
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Excel Options

Genera) : iDisplay options for this workbook: | (BBookt

- Formulas [] Show horizontal scroll bar
Formula Bar Q L;_g)g [:«_ Data [[] Show vertical scroll bar

Gridlines Headings Zoom 100% Zoom Show sheet tabs
Selecti Proofing - , R
Group datesin the AutoFilter menu
Z
2 For objects, show:

Clear headings to turn off o All
the worksheet frame. P e~ : | . Nothing (hide chjects)

Display options for this worksheet: | f&; Sheetl

Eiport Customize Ribbon Show row and column headers

Publich Quick Access Toolbar [C] Show formulas in cells instead of their calculatad result
Add-i [] Show sheet right-to-left
Add-ins
Close [[] Show page breaks
Trust Cent v y
PRI Show a zero in cells that have zero value
Show outline symbeols if an ocutline is applied

Account \ Show gridlines
|

oy N !
e ) @, B
Feedback Gridhine color

4

Options

hfma
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Show/Hlde Excel Ribbon

A D

Reglon bl Total Sales  Vendors
‘Mid GA 691,787  Bob's Fruit

1 Jorth GA 2,108,437  Fruit Direct

ress Alt-F11 in Excel to display
Excel's Visual Basic Editor.

7 Microsoft Visual Basic for Applications - Dashboard Examplexdsx

! File Edit View Insert Format Debug Run Tools Add-Ins Window Help
ME-H famAa2™» a3 FY 2O
= =

# &3 Solver (SOLVERXLAM)

37 ooy ‘ | &2 VBAProject (Dashboard Example.xisx)
| Mountain Frui = = —
4 |Atlanta 1,416,079 " Double-click ThisWorkbook within
avel Oranges
5 |Blue Ridge 383,506 your dashboard spreadsheet.
| : Orange U Glad
6 |Brunswick 235,373

P

] HrcroEﬁsual Basic for Applications - Screen Workbook =

'Hides Excel menu/status bar when Dashboard iz active
Application.ExecuteExceld4Macro "Show.Toolibar (""Ribbon"",False)"”
Application,.DisplayStatusBar = False

End Sub

Private Sub Workbook Deactivate ()

ores Excel menu/status bar when any other workboock is activ
ication.ExecuteExceld4Macro "Show.Toolibar (""Ribbon"",True)"
cation.DisplayStatusBar = True

Qnd Sub

hfma
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Thank you for attending!

I'm happy to hear from you. In particular let me know if you did not
receive the handouts for this presentation.

David Ringstrom, CPA
L) ask@davidringstrom.com
] www.twitter.com/excelwriter
] www.linkedin.com/in/davidringstrom

Is there something you were hoping to learn today but didn't?
Please let me know. You can ask me anything about Excel.
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